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CalcBlox: the Basics
For a description of any component of the CalcBlox window, click on that component in the picture below 
(a tool button or menu, for example).



 About CalcBlox

CalcBlox
CalcBlox is a multi-purpose, multi-function calculator that you can use for all your everyday calculation 
activities. With full OLE (Object Linking and Embedding) functionality, you can integrate CalcBlox directly 
into your Windows 95 work environment. It incorporates the calc-sheet found on some desktop and 

handheld calculators, and has many of the characteristics of a spreadsheet with the advantage that
it provides instant answers, using a familiar style. 

You can attach a CalcBlox directly to a document at the precise location where you need it this 
could be a word processor document, a spreadsheet or any document requiring calculated input. 
Alternatively, you can place a CalcBlox directly on the Windows 95 desktop so that it is readily available at
all times.
        CalcBlox Features
        CalcBlox Window



 CalcBlox Features

First and foremost CalcBlox is a multi-purpose, multi-function calculator that is quick and easy to use, and
that can take care of most of your calculation needs. It is also, however, a versatile and powerful tool with 
a range of advanced features:

CalcSheet: CalcBlox incorporates a CalcSheet that enables you to keep track of all the stages in 
a calculation, even one with many steps and different operators. So, if you make an error at one step, you
can correct it without having to retype the entire calculation. This makes calculations reusable and 
auditable, and you can label the entries for clarity.

Choice of KeyBlox: Apart from the standard KeyBlox (or keypads), CalcBlox contains a number 
of other KeyBlox catering to particular specialized areas, and you can switch between these as you need 
to

these include scientific, computer, and a range of financial calculation KeyBlox. 

Linking and Embedding: CalcBlox calculations have full OLE functionality. You can embed or 
link them into documents or other objects simply by dragging the CalcBlox icon from ToolBlox and 
dropping it in place

you have the choice of displaying the CalcBlox as icons or as the displayed calculation, and of 
editing embedded CalcBlox either in place or in separate windows. You can also place CalcBlox directly 
on the desktop for ease of access. 
CalcBlox can also act as containers for other objects

for example, spreadsheets , NoteBlox notes (which you can use to annotate calculations), and 
ListBlox lists (e.g. for price lists). Again, simply drag the object from ToolBlox and drop it into place.

Templates: CalcBlox has a template feature that you can use to predefine templates for 
calculations that you perform frequently. This means that you can retain the structure and format 
(including the row labels) and change only the data with each new calculation. 

Display Formatting: When you embed a CalcBlox in a container document, you can display it in 
its entirety, as a result only, or as an icon. You can also apply different font, style, size, and color attributes
to selected data in CalcBlox cells. 

Security Features: You can lock and hide CalcBlox cells and you can use password protection to
control access to cells.



 CalcBlox Window

For a description of any component, click on that component in the sample window below (a tool button or
menu, for example). Note that you can use the Blox | View command to specify which components of the 
CalcBlox window are displayed at any time.



New
Creates a new CalcBlox in the CalcBlox window. If you already have a CalcBlox open, you are prompted 
to save it as a file.



Open
Opens a CalcBlox that you have previously saved as a file. You specify the filename and the folder where 
it is located, and the CalcBlox is then displayed in the CalcBlox window.



Save
Saves a CalcBlox to its current filename and folder.



Template
Use to create a CalcBlox with a particular template in place. The Template dialog box presents all existing
CalcBlox templates and you select the one you want by double-clicking on it or by clicking on it and 
choosing OK.



Always on Top
Click this button if you want CalcBlox always to appear on top of other windows on your desktop.



Drag Embed
To embed the current CalcBlox into another application or object, click this button and drag to the desired 
location.



Drag-Link
To create a link to the current CalcBlox in another application or object, click this button and drag to the 
desired location. The button is available only for CalcBlox that have been saved as files.



Set Keyblox

CalcBlox is supplied with a range of KeyBlox, standard, scientific and financial use this option to 
change the current KeyBlox. 



CalcSheet
Contains details of calculations.



KeyBlox
Use this to enter calculation details. 



Display
Entries and results are displayed here.



Status Bar
The status bar is displayed at the bottom of the CalcBlox window. The left part of the status bar displays a
description of the function of menu items and toolbar buttons as you move the mouse pointer over them. 
The right part of the status bar indicates whether the following keys are currently on or off: CAP (Caps 
Lock key is on), NUM (Num Lock key is on), SCRL (Scroll Lock key is on).



Caption Bar
This displays the name of the current CalcBlox. The Minimize, Maximize, and Close buttons are included 
at its right-hand side, the control menu button at its left-hand side. 
To move the CalcBlox window, drag the caption bar. 



Scroll Bar
If the CalcBlox window is not large enough to display your entire text, use the scroll bar to scroll to the 
parts not currently displayed. You can scroll by dragging the scroll box, by clicking the scroll arrows, or by 
pressing the PgUp, PgDn, or Arrow keys on your keyboard.



 About OLE

OLE is a mechanism that allows applications to integrate seamlessly. Documents can contain objects of 
many different types, created by different applications, and the objects have associated with them not 
only the data necessary to display them but also the information needed to edit them. The host document 
is the container; the application that created the object is the server.
Linking and Embedding 
Using OLE you can choose to embed or link an object into a container. 
Embedded objects are stored in your document, and can be edited using the tools and controls of their 
applications. You simply double-click on an object to activate and edit it. When you send an embedded 
object to other people, they too can view and edit it.
With linked objects, only the display data is included in the container, together with a pointer to the original
data. When the original object is updated, so is the linked object. And when you double-click on the linked
object, the original document is immediately launched ready for editing.
In-place (or Visual) Editing 
You can edit an embedded object either in place or in a separate window. Simply double-click on the 
object to activate it. With in-place editing, you edit the object without leaving the container document. The 
necessary menus and tools temporarily replace or supplement those of the container application. Click 
back on the container and its menus and tools reappear. 
Drag-and-Drop 
Drag-and-drop is a fast and intuitive method of moving objects within and across applications. Point to the
object, press and hold down the left mouse button while dragging the object into place, then release the 
button. To move data, first select it and then follow the same steps. 

Move an object or selected data Drag-and-drop 
Create a copy of the object or data CTRL+Drag-and-drop 
Create an OLE link to the original object or 
data

CTRL+SHIFT+Drag-and-drop

Icon or Content Display 
You can display OLE objects either with their content visible or as icons. To switch modes, right-click on 
the inactive object; then choose Display Content or Display as Icon from the pop-up menu. When creating
an object directly from ToolBlox, you can create it in either mode. Objects displayed as icons are 
automatically edited in separate windows; objects with content displayed are automatically edited in 
place.



 About ToolBlox

ToolBlox is your point of access for creating CalcBlox. It is a powerful, customizable toolbar that provides 
fast access to AlphaBlox objects and to other frequently-used applications such as Microsoft Word or 
Excel. A distinguishing feature is that not only can you use it to launch applications but you can also 
create objects directly from it with a single action. 

To launch CalcBlox or any other application included on ToolBlox, simply click on its icon.

To launch CalcBlox with a particular template in place, click the Template icon on ToolBlox. A 
tabbed dialog box is then displayed, with a separate tab for each of the AlphaBlox objects you have 
installed. Select the appropriate tab, and then select one of the templates on that tab by double-clicking 
on it or by clicking on it and choosing OK.

To create an object directly in a container document or on the desktop, drag the object's icon from
ToolBlox to the desired position. You can then activate and work with the object by double-clicking on it. 
You can drag the object as an icon or as an in-place object. The default is set in the ToolBlox preferences,
but there are also keyboard shortcuts. To create an in-place object, press CTRL while dragging the object 
into position; to create an iconized object, press SHIFT instead. 

To add an application to ToolBlox, use Explorer to locate the executable file (WINWORD.EXE for 
example), and drag it into position on ToolBlox. AlphaBlox objects are automatically added to ToolBlox 
when you install them. 

To change ToolBlox preferences, click on the ToolBlox Configure icon. Then use the Preferences 
options to change attributes such as the size and layout of icons and whether objects are embedded by 
default as icons or as in-place objects. 

When ToolBlox is the active task, you can switch between its normal size and a captionized version by 
pressing ESC.



 About AlphaBlox

CalcBlox is part of a suite of components from AlphaBlox Corporation which give you quick and easy 
access to frequently-used items such as notes, calculations, and lists. Many other components are 
currently planned or under development. 
Making full use of OLE functionality, all components integrate seamlessly with each other, with the 

desktop, and with other OLE-compliant applications they can be combined in whatever way suits 
your needs, and are available wherever and whenever required. 
All AlphaBlox tools are designed to be simple, quick, easy, adaptable, compact and affordable. A 
consistent interface style across the components, and the use of common tools for common tasks, 
contributes to more intuitive interaction with the tools.



 Launching CalcBlox from ToolBlox

To launch CalcBlox from ToolBlox, click on the CalcBlox icon.

To launch CalcBlox with a particular template in place, click the Template icon on ToolBlox, and 
then double-click on the template you want. 

To embed a CalcBlox object directly from ToolBlox, drag the CalcBlox icon into position on the 
desktop or in a container document.



 Creating a CalcBlox on the Desktop

There are a number of ways in which you can start CalcBlox:

You can start it on the Desktop by dragging CalcBlox onto the Desktop from ToolBlox. Drag 
CalcBlox from ToolBlox onto the desktop. It is displayed there as a Scrap icon. Double-click on the Scrap 
icon to activate CalcBlox.

You can start a new CalcBlox by clicking on CalcBlox in the ToolBlox

you can subsequently save the CalcBlox with a filename.

Embed CalcBlox within a container application

drag CalcBlox from ToolBlox into the container.

Right-click on the Windows 95 Desktop, then choose New from the menu, and choose AlphaBlox 
CalcBlox Document.

Entering the Calculation Details
1 Enter your calculation details. Click on the right arrow in the Label field to view the Formula field. 

Click on the right arrow in the Number field to view the Interim field.
2 When you have finished creating the CalcBlox, click the Close button to close it.
3 You can now double-click on the Scrap icon at any time to review or modify the calculation. 
4 You can give the Scrap icon a more meaningful name simply by clicking on the current name and 

then typing the new one.

See Also:
Using Formulas



 Using Formulas 

As well as entering values into CalcBlox cells, you can also enter formulas. Typically, these are formulas 
that draw on variables already contained within the CalcBlox. 
To enter a formula into a CalcBlox cell, double click on the cell, click on = (the KeyBlox) and enter the 
formula details.
The operands in a formula can be either constants or variables. Variables are referenced either by their 
row number in the CalcSheet or by their row label. 
To include the value from a particular row in a formula, click on either the row number or on the row label.
Here are some examples of CalcBlox formulas:

=R1*R2 Multiplies the values or Row 1 and Row 2
=Selling Price-
Commission

Subtracts the value in the Commission row 
from that in the Selling Price row.



Interim Field
The interim field contains a running total account of the progress of a calculation. 



Operator Field
The Operator field displays the operator used on the value in the previous Number to arrive at the current 
interim value. The operator displayed here can be any one of the operators available with any of the 
KeyBlox. Double-click on the Operator field to display a drop-down list of available operators.



Formula Field
Displays the value which is operated on by the operator in its contiguous Operator field.



 Using Templates

A CalcBlox template is a master CalcBlox that you can use again and again, changing only the data. For 
example, a template could have predefined labels on a set of rows.
To create a CalcBlox using a particular template, click the Template tool on the CalcBlox toolbar. This 
displays the Template dialog box which lists all available CalcBlox templates. Simply double-click on the 
template you want, or select it and click OK. 
You can also access the Template dialog box using the Apply Template command on the File menu. To 
launch CalcBlox from ToolBlox with a particular template in place, click the Template icon on ToolBlox, 
and then double-click on the template you want. 
Three buttons are included for changing the way the templates are displayed in the Template dialog box

the three views are: Icons, List, and Details. When you choose the Details option, full details of 
each template are displayed (name, size, type, and date and time last modified).



 Creating Your Own Templates

1 Create a new CalcBlox.
2 Enter the labels you want for the rows.
3 Choose the Save As Template command from the File Menu.
4 In the Save As dialog box, enter a name for the template and choose the Save button. This saves 

any text or values in the CalcBlox as a template for future CalcBlox.
5 You can now use the Template button on the toolbar to open your template and use it as the basis 

for a new CalcBlox.



 Embedding a CalcBlox in a Document

1 Open the document in which you want to place the calculation.
2 From ToolBlox, drag CalcBlox into position in the document.
3 Double-click on the CalcBlox to activate it.

If the CalcBlox is displayed as an icon, it opens in a separate window and you perform the 
calculation there. Click the Close button when finished.
If the CalcBlox is displayed as content, the calculation is performed in place. For example, when 
you activate a CalcBlox that is included in Microsoft Word, the Word menus and tools are replaced 
or supplemented with those you need to modify your CalcBlox. When you are finished, click back 
on the Word document and the Word menus and tools reappear.

4 To switch between displaying the CalcBlox as an icon or as a displayed calculation, right-click on 
the object and choose Display as Icon or Display Content from the pop-up menu. Alternatively, use 
the Object | Convert command on the container application's Edit menu.



 Embedding or Linking an Existing CalcBlox
Embedding

To embed an existing CalcBlox into a document or object, click on the Drag Embed button on the 
CalcBlox toolbar and drag to the document or object in which you want the calculation. You can then 
double-click on the CalcBlox to activate and modify it.

Linking

To create a link in another document or object to an existing CalcBlox, click on the Drag Link button and 
drag into place. Note that you must save the CalcBlox as a file before you can do this. Whenever the 
original CalcBlox is updated, the linked CalcBlox is updated also. And you can make changes to the 
original CalcBlox by double-clicking on the linked CalcBlox.



 Embedding an Object in a CalcBlox

For example, to embed a Microsoft Word document in a CalcBlox:
1 Create or open the CalcBlox.
2 From ToolBlox, drag Word into the CalcBlox. Or use the Insert New Object command on the 

CalcBlox Edit menu.
3 Double-click on the document to activate it.

If the document is embedded as an icon, or if it is embedded in a CalcBlox that itself is embedded 
in another document, Word is launched in a separate window. Otherwise it is edited in place.

4 Perform the calculation.
5 If editing in a Word window, click the Close button when finished. If editing in place, click back on 

the CalcBlox to continue.
6 To switch between displaying the Word document as an icon or as content, right-click on the object 

and choose Display as Icon or Display Content from the pop-up menu. Alternatively, use the Object
| Convert command on the CalcBlox Edit menu.



 Switching Between Icon and Content Display

You can display OLE objects either as icons or with their content displayed. To switch modes, right-click 
on the inactive object; then choose Display Content or Display as Icon from the pop-up menu. 
Alternatively, use the Object | Convert command on the container application's Edit menu.
When creating an object directly from ToolBlox, you can create it in either mode. 
Objects displayed as icons are automatically edited in separate windows; objects with content displayed 
are automatically edited in place.



 Tracking CalcBlox

If you have a CalcBlox embedded in a document or other object, you can create a shortcut to it anywhere 
on your system and use it for quick access to the CalcBlox and its container.
To create a shortcut on the desktop, follow these steps:

1 Right-click on the CalcBlox and choose Copy from the shortcut menu.
2 Right-click on the desktop and choose Paste Shortcut from the shortcut menu. A shortcut icon is 

created with a link to the CalcBlox.
3 Close the container document.
4 You can now double-click on the shortcut icon whenever you wish to view the CalcBlox again. The 

container document is immediately opened at the point where the CalcBlox is located. 



 Printing CalcBlox

Use the File | Print command to print the current CalcBlox. You can choose to print it to the default printer,
to any other printer set up on your system, or to a file. You can also specify which pages to print and the 
number of copies required.
Use the File | Print Preview command to see how the CalcBlox will look when printed.
Use the File | Print Setup command to change certain print options such as paper size and orientation, 
the printer to use, and the properties of that printer.



 Mailing CalcBlox

Use the File | Send command to mail a CalcBlox to other people via the electronic mail component of 
Windows 95. The CalcBlox and any embedded objects are sent to the specified receivers.



 Saving CalcBlox as Files

When you create a CalcBlox that is not embedded on the Desktop or attached to another 
document or object, you can save it as a file for future access. Use the File | Save As command. 

When you subsequently edit the file, you can save your changes using the File | Save command 
or the Save button on the toolbar.

When you want to save an embedded or linked CalcBlox to a file, use the File | Save Copy As 
command. This saves a copy of the CalcBlox to a specified file.

To open a CalcBlox you have previously saved to file, use the File | Open command or the Open 
button on the toolbar.



 File Menu

New Creates a new CalcBlox in the CalcBlox window. You are 
prompted to save the current CalcBlox if you have made 
changes to it that you have not already saved.

Open Opens an existing CalcBlox file. In the Open dialog, you 
specify the name of the file and its location. Then click OK 
to open it.

Save Saves the current CalcBlox to its current filename and 
folder. 

Save As Saves the current CalcBlox under a specified name. In the 
Save As dialog box, you specify a name for the file and a 
location. Then click Save to save it. 

Apply 
Template

Creates a new CalcBlox with a particular template in place. 
When the Template dialog box appears, select a template 
and then click OK to display it in the CalcBlox window.

Save As 
Template

Saves the current CalcBlox as a template for future reuse. 
In the Save As dialog box, enter a name for the template 
and then click the Save button. 

Set 
Keyblox

Specifies the particular KeyBlox you want to use.

Print Prints the current CalcBlox. You can choose to print it to the
default printer, to any other printer set up on your system, or
to a file. You can also specify which pages to print and the 
number of copies required. 

Print 
Preview

Displays the CalcBlox as it will appear when printed. 

Print 
Setup

Use to change certain print options such as paper size and 
orientation, the printer to use, and the properties of that 
printer. 

Send Sends a CalcBlox to other people via the electronic mail 
component of Windows 95. 

1, 2, 3, 4 Reopens the most-recently closed CalcBlox files. 
Exit Exits CalcBlox. 



 Edit Menu

Undo Cancels the last entry you made.
Insert Row Inserts a new row in the CalcSheet.
Delete Rows Deletes the selected row from the CalcSheet.
Clear

Clears the value from the selected row in most 
applications, this involves setting it to 0.00. 

Cut Deletes selected data, placing it on the clipboard.
Copy Copies selected data to the clipboard.
Paste Inserts the clipboard contents into your CalcBlox. 
Paste Link Inserts the clipboard contents into your CalcBlox, and 

creates a link between the data in the CalcBlox and the 
source data.

Insert New 
Object

Inserts a new or existing object into a CalcBlox. You can 
insert the object as an icon or with its content displayed. 
You can also choose either to embed the object or to 
create a link to an existing file. See the Insert Object 
Dialog Box

Links Lists any links included in the current CalcBlox and 
enables you to edit them.

Object This command becomes available when you click on an 
object in a CalcBlox. The name of the command differs 

depending on the type of object selected for 
example, Microsoft Excel Worksheet object, ListBlox 
object or NoteBlox object.
Choosing the command displays the Object submenu.

Object | Open Opens the selected object in a separate window, ready for
editing.

Object | Edit Activates a selected object ready for in-place editing. The 
menus and tools required are added to the CalcBlox 
menubar and toolbar.

Object | 
Convert

Enables you to convert a selected object to a different 
object type (where relevant), and also to switch between 
displaying the object as an icon or as content.



 Blox Menu

View Displays a submenu from which you can choose which 
components of the CalcBlox window are displayed

 Toolbar, Status bar, Menu Bar, Caption Bar, and 
CalcSheet. You can also specify that you want the 
CalcSheet to be always displayed on top of other 
applications.

Options Allows you to set a range of options that determine the 
general appearance of CalcBlox. There are four subtabs
covering General, Columns, CalcSheet and KeyBlox 
options.

Font Allows you to specify the font, style and size of entries in
the CalcSheet. You can also set other display attributes 
such as strike-out text, and underlining.

Lock Cells

Locks the current cell or cells data in a locked cell 
cannot be altered. A key symbol in the corner of the cell 
indicates that it is locked.

Unlock Cells

Unlocks the current cell or cells the key symbol 
disappears.

Hide Cells Hides the data in current cell or cells.
Show Cells Use this to show or `unhide’ data in a cell or cells that 

was previously hidden.
Protect 
Document

Use this option to password-protect a CalcBlox. You are 
prompted to enter the password. If you subsequently try 
to access this CalcBlox, you are prompted to enter the 
password. 

Remove 
Protection

Removes password protection from a CalcBlox. You are 
prompted to enter the password you used when you first
protected it.



 Help Menu

CalcBlox 
Help Topics

Opens the CalcBlox online help window.

About 
CalcBlox

Displays CalcBlox version and copyright details.



 Template Dialog Box

The Template dialog box lists all available CalcBlox templates and enables you to create a new CalcBlox 
with a selected Template in place. 
Simply double-click on the template you want, or select it and click OK. 
Three buttons are included for changing the way the templates are displayed in the dialog box. The three 
available views are: Icons, List, and Details. When you choose the Details option, full details of each 
template are displayed (name, size, type, and date and time last modified).



 Save As Template Dialog Box

Use the File | Save As Template command to save a CalcBlox as a template for future CalcBlox. The 
Save As Template dialog box presents the following options:

Save In
Identifies the current folder. The templates currently in that folder are listed in the box below. 
To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 

open one of those folders, simply click on it its contents are then shown in the list below.
Double-clicking on an existing file name in the list saves the template to that file, overwriting the current 
contents of the file. 
File Name
Use to specify a name for the template you want to save. You can specify a full path for the file if you 
wish. If you have selected a file in the list above, its name is automatically entered here.

Save as Type
Specifies the type of file you are saving. CalcBlox Template (*.ctx) is the default option. 

Toolbar
The following tool buttons appear at the top of the Open dialog box:
Up One Level: Opens the folder one level higher than the current one.
Create New Folder: Creates a new folder in the current one.
List: Lists files and folders with their icons and names only.
Details: Lists files and folders with their icons, names, file size, file type, and date last modified.

Save button
Click to save the template to the specified filename and location. If you specify the name of an existing 
file, the current contents of that file will be overwritten. 

Cancel button
Click to close the dialog box without saving the template.



 Options Dialog Box

Use the Blox | Options command to change CalcBlox attributes. The Options dialog box is divided into 
four tabs:

General Options
Columns Options
CalcSheet Options
KeyBlox Options



 General Options Dialog Box
Decimal Places Sets the number of decimal places to be used in 

CalcBlox. This can be fixed or variable, depending 
on your requirements. 
Check the Format thousands check box if you want 
thousands to be marked off. 

Embedded Display When a CalcBlox is embedded in a container 
document, it can be displayed as a CalcSheet, as a 

result only, or as a result and icon select your
preferred option here. 

Always on top Check this if you want CalcBlox always to appear 
on top of other windows on your desktop

Autosize to KeyBlox 
width

Check this to automatically size the CalcBlox 
window to the width of the selected KeyBlox.

Reverse Polish 
Notation

Check this to use reverse Polish notation (postfix 
notation). 

Prompt for summary 
information

When you save a CalcBlox you are prompted to 

enter summary information on it this includes 
details of its title, author and comments.

Tax rate Enter the general tax rate that applies.
Set default Check this to set the current options as the default.



 Columns Options Dialog Box
Heading Enter the heading to appear over each column in 

the CalcSheet.
Width Proportion Specify the relative width of each column in the 

CalcSheet.
Set default Check this to set the current options as the default.



 CalcSheet Options Dialog Box
Formulas Choose whether you want to display formulas or 

their derived values in the Formula column..
Printout You can expand the width and depth of the 

CalcBlox printouts to fit the physical size of the 
page. Check the appropriate check boxes..

Headings

You can display row and column headings
check the appropriate check boxes. You can also 
access the Font dialog box for the headings from 
here.

Number of lines at 
Startup

Specify the number of lines to be displayed. 

Grid Access the Font dialog box for the body of the 
CalcSheet from here.

Set default Check this to set the current options as the default.



 KeyBlox Options Dialog Box
These options allow you to set the font and color of the Total bar. See Font dialog box and Color Dialog 
Box. 
You can also specify the default directory for the KeyBlox. 



 Control Menu

Restore Returns the CalcBlox window to its size and position 
before you chose the Maximize or Minimize command.

Move Enables you to move the CalcBlox window using the 
arrow keys. Choosing the command displays a four-
headed arrow, and you simply press the arrow keys on 
your keyboard to move the window around the screen. 
Press ENTER when finished.

Size Enables you to size the CalcBlox window using the 
arrow keys. Choosing the command displays a four-
headed arrow. First press the arrow key (up, down, left, 
or right) that corresponds to the border you want to 
move; then press the appropriate arrow keys to move 
that border in the desired direction. Press ENTER when 
finished.

Maximize Enlarges the CalcBlox window to fill the entire screen.
Minimize Reduces the CalcBlox window to an icon on the taskbar.
Close Exits CalcBlox.



 Open Dialog Box

Use the File | Open command to open an existing CalcBlox. The Open dialog box presents the following 
options:

Look In
Identifies the current folder. To view how the current folder fits in the hierarchy of folders on your 
computer, click the down arrow. 

To open one of those folders, simply click on it its contents are then shown in the list below the 
Look In box.
To open one of the files or folders listed in the Open dialog box, double-click on it. 
File Name
Use to specify the name of the file you want to open. You can include * as a wildcard, and you can also 
specify the full path for the file. If you have selected a file in the list above, its name is automatically 
entered here.

File of Type
Specifies the type of file to be listed in the Open dialog box. CalcBlox Document (*.cbx) indicates 
CalcBlox files and is the default option. 

Toolbar
The following tool buttons appear at the top of the Open dialog box:
Up One Level: Opens the folder one level higher than the current one.
Create New Folder: Creates a new folder in the current one.
List: Lists files and folders with their icons and names only.
Details: Lists files and folders with their icons, names, file size, file type, and date last modified.

Open button
Click to open the file specified in the File Name box. 

Cancel button
Click to close the dialog box without opening a file.



 Save As Dialog Box

Use the File | Save As command to save a CalcBlox to a specified filename and location. The Save As 
dialog box presents the following options:

Save In
Identifies the current folder. The contents of that folder are listed in the box below. 
To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 

open one of those folders, simply click on it its contents are then shown in the list below the Look In
box.
Double-clicking on an existing file name in the list saves your CalcBlox to that file, overwriting the current 
contents of the file. 
File Name
Use to specify a name for the file you want to save. You can specify a full path for the file if you wish. If 
you have selected a file in the list above, its name is automatically entered here.

Save as Type
Specifies the type of file you are saving. The list includes all file types that CalcBlox supports. CalcBlox 
Document (*.cbx) is the default option. 

Toolbar
The following tool buttons appear at the top of the Open dialog box:
Up One Level: Opens the folder one level higher than the current one.
Create New Folder: Creates a new folder in the current one.
List: Lists files and folders with their icons and names only.
Details: Lists files and folders with their icons, names, file size, file type, and date last modified.

Save button
Click to save your CalcBlox to the specified filename and location. If you specify the name of an existing 
file, the current contents of that file will be overwritten. 

Cancel button
Click to close the dialog box without saving the file.



 Print Dialog Box

Use the File | Print command to print the current CalcBlox. The following options allow you to specify how 
the document should be printed:

Printer
This section provides information about the currently selected printer.
Name: Identifies the currently selected printer. To use a different printer, click on the down arrow and 
select a printer from the list displayed.
Properties: Use this to change the options for the currently selected printer. The options available depend 
on the type of printer it is.
Print to File: Prints the CalcBlox to a file instead of to the printer. You are prompted for the filename and 
location.

Print Range
Use to specify whether you wish to print the entire CalcBlox, a particular range of pages only, or the 
currently selected text only.

Copies
Number of Copies: Specify here the number of copies you want to print. 
Collate: If you are printing more than one copy, use this option to specify whether or not you want the 
copies to be collated.

OK button
Click to print the CalcBlox.

Cancel button
Click to abandon the print job.



 Print Preview Dialog Box

Use the File | Print Preview command to display the current CalcBlox as it would appear when printed. 
When you choose this command, the main CalcBlox window is replaced with a print preview window in 
which one or two pages are displayed in their printed format. The print preview toolbar offers the following
options:
Note: Maximize the window to see all the options.

Print Displays the Print dialog box so that you can send the 
CalcBlox to print.

Next Page Preview the next page.
Prev Page Preview the previous page.
One Page/
Two Page

Preview one or two pages at a time.

Zoom In Zoom in to take a closer look at the page.
Zoom Out Zoom out to view the entire page(s).
Close Return from print preview to the main CalcBlox 

window.



 Print Setup Dialog Box

Use the File | Print Setup command change print settings.

Printer
This section provides information about the currently selected printer. 
To use a different printer, click the down arrow beside the Name box and select a printer from the list 
displayed.
To change the properties of the currently selected printer, click the Properties button. The options 
available depend on the type of printer it is.

Paper
Use to specify the paper size and source.

Orientation
Use to specify the paper orientation: Portrait or Landscape.

OK button
Click to implement any changed settings.

Cancel button
Click to abandon any changes you made.



 Insert Object Dialog Box

Use the Edit | Insert New Object command to insert a new or existing object into a CalcBlox. The object 
can be inserted as an icon or with its content displayed, and can be either linked or embedded. To 
activate and edit the object, simply double-click on it. 
The Insert Object dialog box presents the following options:

Create New
Embeds a new object of the specified type into the current CalcBlox. You specify the object type by 
selecting the appropriate option in the Object Type list.

Create from File
Embeds or links an existing file into the current CalcBlox. You specify the file you want by typing its name 
in the File box. Alternatively, you can use the Browse button to browse through the files and folders on 

your computer until you find the file you want then double-click on it to enter its name automatically 
in the File box.
Select the Link option to specify that you want to link the file instead of embedding it. If you link the file, 
the copy of the file in your CalcBlox is linked to the original source file and is updated whenever the 
source file is updated. If you embed the file, a separate copy is inserted in your CalcBlox with no links to 
the source file. 
Display as Icon / Change Icon
Select Display as Icon to display the object in your CalcBlox as an icon instead of with its content 
displayed. When you select this option, the default icon is displayed and also a Change Icon button which
allows you to choose a different icon.

Result
Describes the result of using the current settings when you insert an object. 

OK button
Click OK to insert the specified object or file into your CalcBlox using the currently selected settings. 

Cancel button
Click Cancel to close the dialog box without inserting an object.



 Convert Dialog Box

Use the Edit | Object | Convert command to convert a selected object to a different file type, to activate it 
using an application other than its original application, or to switch between displaying the object as an 
icon or content. The Convert dialog box presents the following options: 

Current Type
Indicates the current file type.

Object Type
Lists the file types to which the object can be converted, or which it can be activated as.

Convert to
Click this to convert the object to the file type selected in the Object Type list.

Activate as
Click this if you want to edit the object using an application other than its original application. Select the 

required application in the Object Type list the selected application must support the particular 
object type. 

Result
Describes the result of implementing the current settings.

Display as Icon / Change Icon 
Select Display as Icon to display the object in your CalcBlox as an icon instead of with its content 
displayed. When you select this option, the default icon is displayed and also a Change Icon button which
allows you to choose a different icon.

OK button
Click OK to implement your selections. 

Cancel button
Click Cancel instead to close the dialog box without implementing your selections.



 Links Dialog Box

Use the Edit | Links command to list and edit any OLE links included in your CalcBlox. The Links dialog 
box presents the following options:

Links
Lists the links included in your CalcBlox, together with their type and update status.

Source / Type
Indicates the source and file type of the currently selected link.

Update
Use to specify whether you want links to be updated automatically or only on request.

Update Now
Click this to update the currently selected link.

Open Source
Click this to open the source file for the currently selected link.

Change Source
Click this to specify a different source file for the currently selected link. 

Break Link
Click here to disconnect the currently selected link. This is useful if you no longer want changes in the 
source file to be reflected in your CalcBlox.



 Font Dialog Box

Use the Font option in the Options dialog box to change the font attributes of CalcBlox text.

Font
Lists all available fonts and indicates the currently selected one. To change to a different font, select the 
new font from the list.

Font Style and Size
Lists the available font styles and sizes for the currently selected font, and indicates the currently selected
options. To change to a different style or size, select the desired options from the relevant list.

Effects
Use to specify whether the text should be struck out and/or underlined, and the color in which it should be
displayed.

Sample
Displays sample text using the settings currently selected in the Font dialog box.

Script
Lists the available language scripts for the currently selected font, and enables you to select the one you 
want to use.

OK button
Click OK to implement any changes you have made. 

Cancel button
Click Cancel instead to close the dialog box without implementing the changes.



 Color Dialog Box

Use the Color option in the Options dialog box, or click on the Color tool in the CalcBlox toolbar to change
the background color for the CalcBlox. The Color dialog box presents the following options;

Basic Colors
Presents the basic colors available. To select a particular color, simply click on it.

Custom Colors
Displays any custom colors you have previously defined. To edit a custom color, click on it, click on the 
Define Custom Colors button, make your changes, and then click the Add to Custom Colors button.

Define Custom Colors
Click here to define or edit custom colors. To define a custom color, click on the required color in the color 
matrix and then use the slider at the right side of the matrix to adjust the color's attributes. Alternatively, 
specify precise settings for the color using the Hue/Saturation/Luminosity or Red/Green/Blue options.

Add to Custom Colors
When you have defined a custom color, click here to display it in the Custom Color palette on the left of 
the dialog box.

OK button
Click OK to implement the changes you have made. 

Cancel button
Click Cancel instead to abandon your changes.



 Set KeyBlox Dialog Box
Use Set KeyBlox command to change the current KeyBlox.

1 Choose Set KeyBlox from the File Menu.
2 Choose the particular KeyBlox you want to use.

Your chosen KeyBlox remains current until you change it.
 



 Insert Rows Dialog Box
Use the Insert Rows command to insert additional rows into the current CalcSheet.

1 Choose Insert Rows from the Edit Menu.
2 Indicate the row number where you want the insertion to start.
3 Indicate how many rows you want to insert.
4 Choose OK to confirm.



 Inserting and Deleting Rows
Inserting Rows

To insert a row at the bottom of the CalcSheet, press Enter. To insert rows at an intermediate position in 
the CalcSheet, choose Insert Rows from the Edit menu. You are then prompted to specify how many rows
you want to insert and where you want to insert them. See Insert Rows Dialog Box.

Deleting Rows

Click on the row number to select the row you want to delete. To select a number of contiguous rows, hold
down the mouse button and drag over the rows you want. To select non-contiguous rows, hold down 
CTRL and click each row.



 Protecting a CalcBlox Dialog Box
Use the Protect Document option to password-protect a CalcBlox.
Enter the password you want to use. And then re-enter the password. 
When you come to re-access a protected CalcBlox you are prompted to enter the password.

See also
Removing Password Protection



 Removing Password Protection
To remove the protection from a CalcBlox you must enter the password that was used to protect it.



 Security Features
CalcBlox incorporates a range of security features that ensure the integrity of your data. 

You can hide cells

their data is not displayed in the CalcSheet. You can subsequently show the data (unhide it). Use 
the Hide Cells and Show Cells options respectively

these are available on the Blox menu.

You can lock cells. A locked cell is one whose data cannot be changed

either intentionally or by mistake. You can subsequently unlock cells. Use Lock Cells and Unlock 
Cells respectively

these are available from the Blox menu. A key symbol inside a cell indicates that it is locked.

You can password protect a CalcBlox

if you attempt to unlock or unhide cells in a protected CalcBlox, you are prompted to enter the 
password. Use the option Protect Document to password-protect a CalcBlox; use the option Remove 
Protection to remove the password-protection. Both options are available on the Blox menu.



 Changing Views
CalcBlox offers you a range of viewing options. Choose View from the Blox menu and make your 

selections. You can select or deselect any of the following if you deselect them, they are not 
displayed on the CalcBlox: 

Toolbar
Status Bar
Menu Bar
Caption Bar
CalcSheet

Select Always on top if you want the CalcBlox to be displayed on top of other applications on your 
Desktop.

Click on Toolbar Properties to specify details about the toolbar for example, whether you want large
buttons, color buttons, and whether or not you want Tooltips to be displayed.    



Microsoft Office Compatible
CalcBlox is a Microsoft Office compatible product, which means that its toolbars, menus, and accelerator 
keys are similar to those used by Microsoft Office. If you are already using Microsoft Office, which 
includes Microsoft Excel, Word, Microsoft Access and Powerpoint, then many of the tasks you have 
learned to complete in Office can be completed in a similar manner in CalcBlox. AlphaBlox and Microsoft 
hope these similarities will make it easier for you to use our products together and with other Microsoft 
Office Compatible products.
Look for the Microsoft Office Compatible logo when purchasing software. For more information about the 
Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible products, 
in the United States, call Microsoft Customer Service at 1-800-426-9400. Customers outside the United 
States should contact their local Microsoft office. 

CalcBlox and the Office Compatible Features
The skills that you have acquired while using Microsoft Office are applicable to CalcBlox. You will find in 
CalcBlox a menu and toolbar arrangement that is very similar to those of Office and the techniques you 
use for navigating around the application are the same. 
For example, to open a CalcBlox, click on the Open button on the toolbar, and to save a CalcBlox, click 
on the Save button. Of course, you can also use the Open and Save options on the File menu to achieve 
the same results. To discover the function of each button on the CalcBlox toolbar, just position the mouse 
pointer over the button and the tooltip for that button is displayed.

OLE Enhancements
The CalcBlox toolbar includes two buttons (Drag Calc and Drag Link) that offer enhanced OLE 
functionality.

Use the Drag Calc button to embed the current CalcBlox in a container document.

Use the Drag Link button to link the current CalcBlox into a container document.
Toolbar Button Differences
CalcBlox is a compact product, and it has been designed to fit into and complement your Office and other 
applications. An important element in the design is the convenient, small-sized window. Because of this, 
not all the Office functions can be placed on the CalcBlox toolbar. They are, however, available in the 
normal way from menus and shortcut keys.

In particular, you can access Cut, Copy and Paste from the Edit menu or by using the standard 
accelerator keys: Ctrl+X for Cut, Ctrl+C for Copy and Ctrl+V for Paste.

Using CalcBlox with Microsoft Office
CalcBlox incorporates full OLE functionality, and you can integrate it directly with Microsoft Office. For 
example, you might want to embed detailed costings into a quotation in a Word document.
The are a number of ways in which you can integrate Office applications with CalcBlox (and indeed other 
OfficeBlox applications). Some of the tasks that you can perform are described below.

Embedding a CalcBlox in a Word Document
You can embed both new and existing CalcBlox into a Word document.

To embed a new CalcBlox in a Word document, open the document within which you want to 
place the CalcBlox and from ToolBlox, drag CalcBlox into position in the document.



To embed a previously created CalcBlox, open it and then use the Drag Calc tool to drag it into 
position in the document. Once the CalcBlox is in position in the document, double-click on it to activate it.

Linking a CalcBlox to an Excel Spreadsheet
To link a CalcBlox, open it and then use the Drag Link tool to drag it into position in the target document. 
For example, you could link detailed sales figures from a CalcBlox into an Excel spreadsheet. 

Note: OLE works only with saved files, so you must save a CalcBlox as a file before you can link it
to an Office application.



CalcBlox Function Reference
In normal mode, the calculator works just as a hand held calculator would work - that is you type in 
various values using standard operators (+, - , /, *) and a result is build up.
However, the CalcBlox has many more operators available to you from which you can build up more 
complex equations.

See also
CalcSheet Operator Functionality
CalcBlox Functions



CalcSheet Operator Functionality

Standard operator selection
You may have noticed on the CalcSheet that there is an OP column (short for operator) which you can 
use exactly for this. For example , type in:
4+3 =
and you should get 7.

Now, to change the + operator to a ^ operator (power function) simply double click on the + sign and drop 
down the list of operators. The operator above + is the power sign.
Now you should see your result change to 64.

Inputting equations
The CalcBlox CalcSheet also has another facet which allows the input of equations directly into cells. This
gives it a “spreadsheet” type capability for building far more complex and concise calculations.

Basic Input
To get an equation into a cell, simply double click on the cell. This will give you an edit field into which you
can type the equation.

For example:
Double click on a cell in the number column and type in:
=(4*20)+(3^4)

You should now see 161 after you have either:
I) pressed enter on your computer keyboard
ii) pressed the red ENT key on your KeyBlox
iii) clicked on another cell that does not contain a label.

Note: you must start you equation off with the = sign.

Referencing
It is possible to include other rows in your equation. Suppose you have a CalcSheet that has two rows, 
Profit and Loss that looks something like:

You may want to add a final line, Revenue that sums Profit and Loss. This can be done in three ways:

 Double click on the number column at the third row and enter either:
i) =R1+R2
ii) =SUM(R1:R2)



iii) =Profit+Loss

And either way, you will see:

Hint:
While you are entering your equation, you can use both the computer keyboard and the buttons on the 
KeyBlox. Also note that you can click on the Label, e.g. Profit to put the word profit in the equation. You 
can also click on the row number to enter R followed by the row number.

Note: the best way to enter equations is to use labels because if you move the row you will not 
need to adjust any equations - which you would have to do if you used the Rx nomenclature.



CalcBlox Functions

!Factorial ( ) Parentheses
 ^ (Power) 1/X (Inverse or Reciprocal
<,>, <> (Comparison Operators) <<,>>Bitwise Shift
ABS ACOS
ALOG AND
ASIN ATAN
AVG CEILING
COS COSH
FLOOR FRAC
IF INT
LOG MOD
NLOG NOT
OR RAND
ROUND SDV (Standard Deviation)
SIGN SIN
SINH SQR
SQRT SUM
TAN TANH
TRUNC XOR (Exclusive OR)



 ! (Factorial)
Returns the factorial of a number. 4! evaluates to 4*3*2*1 = 24.
note:
0! =1 and 0.5!=1



^ (Power)
Raises the number to the left or the operator to the power of the number to the right of the operator, e.g.:
=3^2
yields 9.



1/X (Inverse or Reciprocal)
This function inverts the value entered. For example:
1/X (4) yields 0.25



<,>,<> (Comparison Operators)

See If Operator. 



<<,>> (Bitwise shift)
These operators shift binary bits to the left or right.
For example
<< 1001
yields
10010



ACOS
Returns the ARC-Cosine of a number. The value is the cosine of the angle you want and must be from -1 
to 1.

ACOS(-0.5)= 2.094395



ABS
Returns the absolute value of a number (the value without its sign).
ABS(-4) yields 4



ALOG
Returns the anti-logarithm of a number in base 10:
ALOG(1.4) = 25



AND
Logically ANDs two values to produce a third. For example:
1001 AND 1111 
=1001

Note:
0 AND 1 = 0
1 AND 0 = 0
1 AND 1 = 1
0 AND 0 = 0



ASIN
Returns the ARCSINE of a number. This is the angle whose sine is the number.
ASIN(0.5) = 30



ATAN
Returns the ARCTANGENT of a number. This is the angle whose tangent is the number.
ATAN(1)=45



AVG
This returns the average of a list of numbers.
AVG(1,2,3) = 2

Note: you can also reference rows in the format:
=AVG(r1:r3) to average rows one, two and three.



CEILING
Returns the number rounded up away from 0.
CEILING(2.5) = 3



COS
Returns the COSINE of the given angle.
COS(60)=0.5



( ) Parentheses
Used to bracket a section of a calculation which means the expression inside the brackets is evaluated as
one result.
e.g.
=4/(2+2)
would yield 1 as the 4 is divided by the result of the bracketed expression (4).



COSH
Returns the HYPERBOLIC COSINE of a number.
(COSH(x)=(ex+e-x) / 2)

COSH(4)=27.30823 radians



FLOOR
Returns the number rounded down towards 0.
FLOOR(2.5)=2



FRAC
Returns the fractional part of the number.
FRAC(4.3)=0.3



IF
Syntax:
IF (expression,value1,value2)

IF is used to evaluate conditional expressions. You can use comparison operators with IF, such as <,> 
and <> and the AND and OR operators.

For example: 
IF (1=1,4,2) yields 4
IF (Profit>0 AND Year=1994,Sales,Sales / 2)



INT
Returns the integer (whole) part of a number.
INT(4.3) = 4



LOG
Returns the logarithm of a number to base 10.
LOG (10)=1



MOD
Returns the remainder or a division.
9 MOD 5=4



NLOG
Returns the natural logarithm of a number. The number must be positive.
NLOG(86)=4.454347



NOT
Used with binary values.    Inverts the number (i.e. changes 1’s to 0’s and 0’s to 1’s).
NOT 110
=001



OR
Logically OR’s two values to product a third.
110 OR 111 = 111

Note:
1 OR 0 = 1
0 OR 1 = 1
1 OR 1= 1
0 OR 0 = 0



RAND
Returns a random number. The value in the brackets is irrelevant.



ROUND
Rounds the number UP or DOWN to the nearest integer.
ROUND(4.6)=5
ROUND(4.2)=4



SDV (Standard Deviation)
This function measures how widely values are dispersed from the average value (the mean).
Syntax: SDV(number 1,number 2,number 3,number x)



SIGN
Returns 1 for a positive number and -1 for a negative number and 0 for 0.



SIN
Returns the SINE of the given angle.
SIN(30)=0.5



SINH
Returns the HYPERBOLIC SINE of the given number. 
SINH(1)=1.18



SQR
Returns the SQUARE of a number - that is the number multiplied by itself.
SQR(4)=16
SQR(12+4)=256



SQRT
Returns the square root of the given number,
SQRT(16)=4
SQRT(250+6)=16



SUM
This function summates a group of numbers. You can also use row references in here.
SUM(1,2,3)=6
note: you could use SUM(r1:r5) to summate rows one through to five.



TAN
Returns the TANGENT of the given angle.
TAN(45)=1



TANH
Returns the HYPERBOLIC tangent of a number.
TANH(-2)=-0.96403



TRUNC
Removes the decimal part of a number.
TRUNC(4.3)=4



XOR (Exclusive OR)
Logically XOR’s two values to product a third.
111 XOR 101 = 010

1 XOR 1 = 0
1 XOR 0 = 1
0 XOR 1 = 1
0 XOR 0 = 0




